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Introduction 

 

Introduction 

 

This section provides valuable information about teaching TechnoFit. It 

includes a description of the Teacher Guide, as well as an overview of the 

course. In addition, there are ideas for implementation and technology 

integration.  

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 
 

How to Use this Guide 

Course Overview 

Technology Integration Ideas 
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How to Use This Guide 

This Teacher Guide contains the following: 

Getting Started – This section contains a course description, as well as ideas for implementation. 

Course Instructions – The course is comprised of six sessions, each focused on a problem-solving 

task that aligns with the project theme. Each session includes assignments that break down the 

task into manageable steps. The components of each session are as follows: 

➢ Overview – An explanation of the session activities and their purpose. 

➢ Materials – A list of handouts, samples, templates, and teacher resource materials 

needed to teach the session. 

➢ Teaching Strategies – Instructional methods recommended for teaching the activities. 

➢ Lesson Plan – A detailed list of each step in the session. 

➢ Learning Objectives – A summary of the content knowledge and technical skills taught 

throughout the session.  

➢ Assignments – A session consists of assignments completed by students. Actions to be 

performed on the computer by the student are indicated with a triangle (). 

Background information is indicated with a dash (–). 

➢ Review – A session review contains a list of fill-in-the-blank, multiple choice, or short-

answer questions intended to review Microsoft Publisher commands (answers included). 

➢ Skill Review – An additional theme-related assignment intended to review publishing skills 

(includes completed sample). 

➢ Extension Activity – An additional activity that relates to the problem-solving task 

presented in the session. 

 

Appendices – this section contains additional information or materials including the following 

resources. 

➢ Skill Summary – A list of skills taught during this course. 

➢ Glossary – A definition of each term. 

➢ Contact Information – How to contact TechnoKids Inc. for curriculum support.  
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TechnoFit Overview 

In this course, students become members of the TechnoFit Club and take the "Be Fit Challenge". 

This challenge dares participants to eat right, be fit, and live well! To prepare for the task they learn 

about healthy eating and exercise. Afterwards they design a food guide and fitness poster. They 

then prepare for the upcoming Be Fit Challenge Event, which is a celebration that includes fun 

fitness activities and great tasting food. To plan for the event, students design a menu and send 

invitations. With the event fast approaching, certificates are created for each participant of the 

Be Fit Challenge to recognize their efforts to be healthy. These are then handed out at the event. 

 

Eat Right, Be Fit, Live Well! 

 

Students complete the following tasks: 

 

➢ In Session 1, students join the TechnoFit Club (TFC). The TFC’s motto is "Eat Right, Be Fit, 

Live Well!" To become a member, students learn about being healthy by watching "The 

Be Fit Challenge" video. Once they are familiar with the importance of diet and exercise, 

they are awarded a membership card. This card includes their name, pictures, and other 

vital information that gains them admittance to this elite club. 

 

➢ In Session 2, students learn about a balanced diet. To help TechnoFit Club members 

make healthy food choices, students watch the video Eat Right. Afterwards, they create 

a Be Fit Food Guide, which contains pictures of food items organized under Food Group 

headings. This guide is a great way to help students make healthy food choices.  

 

➢ In Session 3, students learn about the importance of exercise. To help TechnoFit Club 

members "be fit" they make a poster showing all the things they do to stay active. This 

poster is a great way to show others how to live healthy.  

 

➢ In Session 4, students help to plan an upcoming event. The TechnoFit Club is hosting a Be 

Fit Challenge Event. All TFC members will be there! Students must plan the kind of food 

people will eat. They create a healthy menu, being sure to include food from all the 

Food Groups. 

 

➢ In Session 5, students create an invitation to invite TechnoFit Club members to come to 

the Be Fit Challenge Event. To start, they view a sample to get ideas. Afterwards, they 

plan the content of their own invitation. Microsoft Publisher is then used to create a side-

fold card.  

 

➢ In Session 6, students take part in the Be Fit Challenge Event. All TechnoFit Club members 

who took part in the Be Fit Challenge are to be awarded a certificate in recognition of 

their efforts to eat right and be fit. To prepare, students make a certificate for themselves 

or another TechnoFit Club member using Publisher. These awards are then handed out 

by the teacher to acknowledge each student's healthy lifestyle choices. 
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Technology Integration Ideas 

TechnoFit is a cross-curricular unit that integrates technology into curriculum. In this course, 

students become health advocates. They raise awareness about the importance of eating 

nutritious food and exercise. The activities blend technology into health education, social 

studies, language arts, and visual arts. Lessons are ideal for primary and elementary students. 

 

Below are some suggestions for implementing TechnoFit: 

 

• Digital Literacy Class: Teach TechnoFit as part of a technology course. The activities 

target desktop publishing skills. Students gain expertise with creating publications such as 

membership cards, posters, invitations, and more using Microsoft Publisher. A customized 

Quick Access toolbar is used to simplify finding tools – making it ideal for young learners. 

• Health Education Unit: This course integrates into any health or social studies unit related 

to nutrition, diet, exercise, or wellness.  By creating a series of publications about health-

related topics, students gain an understanding of a healthy lifestyle. They create a food 

guide, design a poster about exercise, and plan a menu. Extension activities include 

healthy recipes designed especially for primary children. 

• Physical Education Class: Physical education teachers may need to include health and 

nutrition as part of their curriculum. Alternatively, if the gymnasium is not available, 

TechnoFit activities can make an excellent alternative to doing exercise. The technology 

course has activities that are ideal for a PE teacher such as the My Fitness poster and Not 

Fit poster. 

• Language Arts Class: An emphasis in TechnoFit is on communication skills. Students 

convey a message about the importance of health and nutrition by effectively 

combining text and images. Terms or search words are often included in assignments to 

help with correct spelling. 

• Visual Arts Class: Target visual arts learning outcomes with TechnoFit. Graphic design is an 

important element of the lessons. Students apply their creativity to organize information 

and arrange content.  

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 2 Eat Right! 

 

Session 2 

Eat Right! 

 

In this session, students learn about a balanced diet. To help TechnoFit Club 

members make healthy food choices, students watch the video Eat Right. 

Afterwards, they create a Be Fit Food Guide, which contains pictures of food 

items organized under Food Group headings. This guide is a great way to help 

students make healthy food choices. 

 

Eat Right! 

 

Assignment 3 Eat Right to Be Healthy 

Assignment 4 My Be Fit Guide 

 

Session 2 Review: Food Groups 

Session 2 Skill Review: What is for Dinner? 

Session 2 Extension Activity: Food Servings 
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Session 2 Getting Started 

Overview 

 

In this session, students learn about a balanced diet. To help TechnoFit Club members make 

healthy food choices, students watch the video Eat Right. Afterwards, they create a Be Fit Food 

Guide, which contains pictures of food items organized under Food Group headings. This guide is 

a great way to help students make healthy food choices. 

 

Eat Right! 

 

Materials 

• Publisher  

• Customized Quick Access Toolbar 

• PowerPoint (Optional) 

• Fit Folder 

o Eat Right video  

o Guide.pdf (Optional) 

o Shop.pptx (Optional) 

• Guide.pub sample (Optional) 

• Food Cards (Optional) 

• Session 2 Review: Food Groups (Optional) 

• Session 2 Skill Review: What’s for Dinner (Optional) 

o Dinner sample for Skill Review 

 

Teacher Preparation 
(Refer to the Prepare to Teach section of this course for instructions) 

• Print or view the Guide sample (Optional) 

• Print the Food Cards resource. Cut out each card. Sort each item on the cards into food 

groups. (Optional) 

• Download the Tool Summary and/or Publisher Flashcards from TechnoHub. (Optional) 

 

 

Teaching Strategy 

 

In this session, students learn about healthy eating. Explain scenario to students: 

 

As part of the Be Fit Challenge, you need to eat right. To help you learn 

about the importance of a balanced diet watch the Eat Right video. 

Then open Microsoft Publisher and create a “Be Fit Food Guide.” This 

guide will contain food items organized by their Food Group. It is sure to 

be a great help when you are trying to make healthy food choices. 
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Assignment 3: Eat Right to Be Healthy 

 

In this assignment, students watch the Eat Right video to learn about the importance of a 

balanced diet. Afterwards, use the Food Cards to teach students about food groups. 

 

To help your students understand how to sort food into categories, TechnoFit resources include a 

set of 48 food cards. Use them to teach food groups. Sample food cards: 

 

        
apple carrot cheese milk bread cereal steak fish 

 

1. Write the food group names onto the board.  

2. Hold up a food card and have students identify the food group. 

3. Place the card under the correct heading. 

 

This assignment includes the optional activity Time to Shop. It requires PowerPoint. Students move 

the correct foods into the shopping cart according to the food group. 

 

    
Meat and Fish Milk Products Grains Fruits and Vegetables 

 

 
 

Assignment 4: My Be Fit Guide 

 

In this assignment, students create a Be Fit Guide. To start they create the Food Group headings 

using WordArt. Afterwards, pictures of healthy food items are organized under the correct 

heading. Students should be familiar with the Publisher commands as they were introduced in 

the previous session. A sample Guide is available if you would like to show a completed 

publication to students prior to beginning. 

 

You may wish to write the Food Group headings and some food words on the board to help 

students with the spelling. 

 

A grading scheme is available (Teacher Resources > Assessment > TechnoFit Rubric) if you would 

like to assess the completed Food Guide. 

 
Activity Poor - 1 Fair - 2 Good - 3 Excellent -4 

Food Guide 

Sort food items 

into their Food 

Groups using 

pictures and 

WordArt. 

Items incorrectly sorted Some items correctly sorted All items correctly sorted, 3 items per 

group 

All items correctly sorted, 4 items per 

group 

Words are difficult to read Some words are difficult to read Most words are easy to read All words are easy to read 

Words not formatted Words formatted with only one option Words formatted with more than one 

tool 

Words formatted with many tool 

options 

Unbalanced layout Somewhat balanced layout Balanced layout Balanced and eye-catching layout 

TEACHER TIP 

 

Where you live has a lot to do with what you eat. For this reason, the food guidelines are slightly 

different around the world. If you are an American educator, visit www.myplate.gov. If you are an 

educator in another country, use the Internet to find your food guide. Use the search term country 

name dietary guidelines to get you started. 
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Lesson Plan 

Assignment 3 - Eat Right to Be Healthy 

• Watch the Eat Right video. 

• Answer questions about the video. 

• Learn about food groups. 

• Place items into the cart that match the food group (optional). 

 

Assignment 4 - My Be Fit Guide 

• Open Microsoft Publisher to a Blank 8.5 x 11" publication. 

• Add the title Be Fit Guide using a text box. Format the font and adjust alignment. 

• Use WordArt to add Food Group names. 

• Under each Food Group, insert pictures of food items from that group. 

• Save publication as guide. 

• Print the publication. 

• Close Publisher. 
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Learning Objectives 

 

Content Knowledge 

• classify food into food groups 

 

Operating Environment 

• open and close a program 

• save a publication 

• print a publication 

 

Desktop Publishing 

• draw a text box and add text into the object 

• format the font, size, style, color, and alignment of text to make the words stand out 

• add WordArt to a publication with an eye-catching design 

• search for and insert suitable pictures into a publication 

• position and resize objects in a publication to create a good layout 

• select a blank full-page publication 

 

Applied Technology 

• create a food guide using Microsoft Publisher 
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Assignment 3 Eat Right to Be Healthy 

All TechnoFit Club members must eat right. To learn more about  

healthy eating, watch the "Eat Right" video and then answer the  

questions. 

 

Watch the Eat Right Video 

 Ask your teacher for the Eat Right video file. 

 Watch, listen, and learn! 

 

 

1. List two healthy foods: 

   

   

 

2. To be healthy you need to eat different foods. Food can be sorted into groups.  

Circle the food group for each item. 
  

    
 apple Meat and Fish Fruits and Vegetables 

    

    

 bun Grains Milk Products 

    

 cheese Milk Products Meat and Fish 
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Time to Shop (Optional) 

 

3. Put the correct food into the cart. 

 

 Ask your teacher for the Shop file. Open it in PowerPoint. 

 

 Press the DOWN ARROW to shop.  

 

 Drag the meat and fish into the cart: 

 

 Keep shopping. Put groups of food into the cart. 

   

Milk Products Grains Fruits and Vegetables 

 

 Save your work when you are done shopping.  

 

Close PowerPoint 
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Assignment 4 My Be Fit Guide 

 

Open a Blank Page in Publisher 

 Open Publisher.  

 Click Blank 8.5 x 11". 

 
 

 You might need to click Show Whole Page:  

 
 

Add the Title "Be Fit Guide" using a Text Box 

 On the Quick Access toolbar, click Draw a Text Box.   

 Draw a text box between the blue margin guides. 

 Type the title Student Name's Be Fit Guide. 

 

  

As part of the Be Fit Challenge you need to eat right!  

 

Create your own Be Fit Food Guide to help you and 

your friends make healthy choices. 

Create the food guide 

inside the blue lines. 
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Make the Words Look Good 

 Triple click the text to select it all. Alex's Be Fit Guide 

 From the Home tab, click the Font Color arrow.  

 

 Pick a color from the palette. 

 

 Use your skills to change the way the words look using these Font group commands. 

 
Change the font of the letters. 

 
Change the size of the letters. 

 
Add a bold style to make the letters darker. 

 
Slant the letters to the right. 

 
Place a line below the letters. 

 

 

Center the Title 

 Select the text. 

 From the Home tab, click Center.  

 
 

Add Food Group Names using WordArt 

 Click on the page where you want to add a Food Group name. 

 On the Quick Access toolbar, click Insert WordArt.  
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 Pick a WordArt style from the gallery. 

 

 Type Grains. Click OK. 

 

 Use your skills to move , resize , and rotate   the WordArt. 

 Add the other food groups using WordArt. 

  
 

Add Pictures of Food Items for Each Group 

 On the Quick Access toolbar, click Online Pictures.  

 In the search box, type a healthy food. Press ENTER. 

 
 

Search Word Ideas 

apple cereal carrot steak cheese 

banana rice pepper chicken milk 

orange bread lettuce egg ice cream 
  

TIP: If you make a mistake, you can fix it: 
 

1. Click on the WordArt.  

2. Click the WordArt Tools Format tab.  

3. Click Edit Text to change the letters.  

4. Click OK. 
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 Look at the results. Pick one you like, then click Insert. 

 
 

 Use your skills to move , resize , and rotate   the picture. 

 Keep adding pictures of food. Place two or three food items in each Food Group. 

 

 

Complete the Food Guide 

 Apply what you know to complete the poster. 

    
 

 

Save and Print the Food Guide 

 Save it: 

o Click Save on the Quick Access Toolbar.   

o Go to the place where you save your work. 

o Name the file guide. Click Save. 

 Print it: 

o Click the File tab. Click Print. 

o Click the Print button.  

 

 

Close Publisher 

TIPS:  
 

✓ Make sure the Food Group names are easy to read. 

✓ Put the Food Groups at different places on the page. 

✓ Use colorful pictures. 

✓ Use the whole page BUT stay in the blue lines or your work 

might not print. 

Drag the scroll bar 

down to see more 

pictures. 
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Session 2 Review: Food Groups 

Circle the food that does not belong in the Food Group? 

 

 

 

1. 

 
 

 

    

 

 

2. 

   

    

 

 

3. 

   

    

 

 

4. 

   

    

 

 

5. 

   

    

 

 

/5 
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Session 2 Skill Review: What is for Dinner? 

To eat right you need to eat food from every Food Group. Plan a dinner that includes food from 

all the Food Groups.  

 

1. Open Microsoft Publisher. 
 

  

2. Click New and pick Blank 8.5 x 11”. 

  

3. Add My Dinner using WordArt. 
 

  

4. Add pictures of the food you will eat for dinner. 
 

 Find at least one picture from each food group. 

  

5. Save the file in your student folder as dinner. 

  

6.  Print your work and give it to your teacher. 

  

7.  Close Publisher. 
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Session 2 Extension Activity: Food Servings 

Your body needs food to be healthy. You need to eat a certain amount of food from each 

Food Group to make sure you are getting all the nutrients you need.  

 

How many servings do you need from each Food Group? 

 

Complete the chart below. 

 

Food Group Amount 
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This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



Alex’s Be Fit Guide 



Swim 

Play Basketball 

Run 

Bike 

Play Soccer 



Apples with Peanut Butter 

Dip apples in melted peanut butter. This is 

a tasty treat. 

Pepperoni Pizza 

Fresh bread crust topped with tomato 

sauce, cheese, and pepperoni. 

Milk 

Choose from white or chocolate milk. 

Carrot Sticks 

Great for dipping in fresh yogurt. 

This menu by Fit Ness 




